Bab 1 
Pengenalan Komputer Desain

a. Kompetensi Dasar dan Indikator
· Kompetensi Dasar :
Setelah menyelesaikan pokok bahasan Pengenalan Komputer Desain dengan konstentrasi Desain Perhiasan, mahasiswa memahami mengenai pentingnya illustrasi dan gambar desain dalam industri perhiasan; mahasiswa juga mengetahui tentang berbagai program dan aplikasi yang dibutuhkan dalam membuat gambar ilustrasi desain perhiasan dengan menggunakan komputer sebagai alat bantu kerja.
· Indikator :
1. Mengetahui perkembangan penggunaaan komputer sebagai komponen utama dalam membuat desain.
2. Mengetahui dan memahami jenis program pengolah grafis.
3. Mengetahui dan memahami format grafis jenis grafik vektor dan bitmap beserta contohnya.
4. Mengetahui berbagai implementasi komputer desain dalam kehidupan.

b. Pokok Bahasan : Pengenalan Komputer sebagai alat untuk membuat desain

c. Sub Pokok Bahasan : 
· Sekilas Komputer Desain sebagai media olah grafis
· Macam dan Jenis program pengolah Grafis
· Mengenal macam format gambar/grafis yang diolah dalam komputer
·  Implementasi grafis berbantu komputer dalam dunia nyata

d. Estimasi Waktu : 4 x 45 menit

e. Media Pembelajaran : LCD projector dan Komputer




1.1 Sekilas Komputer Desain sebagai media olah grafis
	Komputer Desain adalah teknik-teknik dalam ilmu komputer untuk merepresentasikan data gambar atau visual dengan menggunakan komputer. Dengan bahasa lain, istilah komputer desain juga dapat diartikan segala sesuatu selain teks atau suara. Seiring dengan perkembangan teknologi dewasa ini, gambar-gambar yang dihasilkan dan ditampilkan pada komputer menjadi bagian kehidupan sehari-hari yang dapat ditemui misalnya pada televisi, koran dan majalah yang fungsinya untuk menampilkan hasil yang lebih komunikatif dan realistis. Selain itu juga aplikasi yang nyata dari Komputer Desain adalah untuk visualisasi data dalam bentuk grafis 2D atau 3D dilengkapi dengan animasi. 
	Walaupun bentuk grafis 3D lebih realistis, namun bentuk 2D masih banyak dipergunakan. Grafis komputer muncul sebagai bagian ilmu komputer yang mempelajari proses pembuatan bentuk geometrik dan manipulasi konten visual secara digital. Visualisasi informasi dan sains telah menjadi fokus penelitian terutama yang berkaitan dengan fenomena-fenomena 3D dalam bidang purwarupa produk khususnya di bidang pembuatan purwarupa perhiasan. Penekanan diberikan dalam rangka menjawab pertanyaan bagaimana menghasilkan gambar benda yang realistis sesuai dengan kondisi dan situasi yang terjadi.

1.2 Macam dan Jenis program pengolah Grafis
	Komputer Desain bukan ilmu yang berdiri sendiri. Pada dasarnya banyak ilmu yang menyokong sekaligus menjadi dasar Komputer Desain, misalnya ilmu menggambar dasar dengan software 2D (program mengolah gambar dengan file vektor dan bitmap) dan 3D (program mengolah gambar dengan 3 sombu objek). Aplikasi pengolah tata letak (layout), Aplikasi mengedit/penyempurna Gambar, Pembuatan grafis modelling, dll. Program pengolah grafis yang terkenal adalah Adobe FrameMaker, Adobe InDesign, Adobe PageMaker, Corel Ventura, Microsoft Publisher, Quark Xpress. 

	1.2.1 Aplikasi pengolah vektor
	Aplikasi ini dapat digunakan untuk membuat gambar dalam bentuk vektor/garis sehingga sering disebut sebagai Illustrator Program. Seluruh objek yang dihasilkan berupa kombinasi beberapa garis, baik berupa garis lurus maupun lengkung. Aplikasi yang termasuk dalam kelompok ini adalah Adobe Illustrator, Beneba Canvas, CorelDRAW, Macromedia Freehand, Metacreations Expression, dan Micrografx Designer. Untuk Modul pembelajaran mata kuliah Komputer Desain adalah menggunakan program Adobe Illustrator, yang merupakan program aplikasi untuk membuat gambar berbasis vektor yaitu objek gambar yang dibentuk melalui kombinasi garis dan titik (dot), Adobe Illustrator merupakan program standar grafis Internasional dalam merancang dan mendesain gambar dengan teknik vector base. 

	1.2.2 Aplikasi pengolah pixel/Bitmap
	Program ini digunakan untuk mengolah gambar atau manipulasi foto (photo retouching). Semua objek yang diolah dalam progam-program tersebut dianggap sebagai kombinasi beberapa titik-titik kecil (pixel) yang memiliki kerapatan dan warna tertentu. Gambar dalam foto terbentuk dari beberapa kumpulan titik-titik kecil (pixel) yang memiliki kerapatan dan warna tertentu. Meskipun begitu, program yang termasuk dalam kelompok ini dapat juga mengolah teks dan garis, akan tetapi dianggap sebagai kumpulan titik-titik kecil (pixel). Objek yang diimpor dari program pengolah vektor/ garis, setelah diolah dengan program pengolah pixel secara otomatis akan dikonversikan menjadi bentuk titik-titik kecil (pixel). Di antara program aplikasi yang termasuk dalam kelompok ini adalah Adobe Photoshop, Corel PHOTO-PAINT, Microsoft Photo Editor, Macromedia Fireworks, Macromedia Xres, Metacreations Painter, Metacreations Live Picture, Micrografx Picture Publisher, dan Wright Image. 

          [image: ::Downloads:perbedaan-grafis-vektor-bitmap1.jpg]
Tabel 1.1. Perbandingan file antara vektor dan pixel/bitmap
[image: ::Downloads:Perbedaan Vektor dan Bitmap yang Lengkap dan Mudah Dipahami,.jpg]
Gambar 1.1. Perbandingan visual antara vektor (kiri) dan pixel/bitmap (kanan)

1.3 Mengenal macam format gambar/grafis yang diolah dalam komputer
	Seperti halnya gambar-gambar file komputer yang terdiri dari berbagai ekstensi, gambar vektor digital juga memiliki berbagai ekstensi atau format file. Jika JPG, GIF, atau PNG menjadi ekstensi gambar bitmap yang populer, Anda juga harus tahu berbagai macam format file grafis vektor jika sedang menggeluti dunia desain grafis. Meski ada sebuah ekstensi atau format file berbasis grafis vektor, terkadang ekstensi tersebut juga bisa diterapkan pada representasi citra grafis bitmap. Namun ada pula ekstensi yang memang terkhusus hanya untuk grafis vektor. Berikut ini adalah 3 format file grafis vektor yang cukup populer dipakai, terutama saat desainer menggunakan program seperti CorelDraw, Adobe Illustrator, Macromedia FreeHand, Inkscape, dan lain-lain. Format gambar tersebut antara lain:

	1.3.1 EPS
	EPS atau merupakan singkatan dari Encasulapted Postscript, salah satu format file grafis vektor. Ekstensi ini berguna untuk membuat antarmuka grafis vektor, dan jenis mesin yang paling sering menggunakan PostScript ini adalah mesin-mesin dari perangkat Apple Maccintosh. Selain itu EPS juga dipakai pada Adobe Illustrator, meskipun program ini juga memiliki ekstensi grafis vektor bawaan. Selain EPS menjadi ekstensi berbasis grafis vektor, pada pengembangannya juga mengikutsertakan suatu bitmap pratayang dengan kode ASCII. Khusus untuk bitmap, format file ini hanya bisa menampilkan pratayang hitam-putih. Format file EPS juga mampu mendukung berbagai macam modus wanra, mulai dari sistem warna RGB, Lab, CMYK, Duplex, Warna Berindeks, bahkan sampai pewarnaan Skala Abu-abu. Bahkan lebih dari itu, EPS juga menuruni kemampuan PostScript untuk menampung berbagai jenis font tulisan.

	1.3.2 Scalable Vector Graphics
	Untuk format file grafis vektor selanjutnya adalah Scalable Vector Graphics atau disingkat SVG. Ekstensi ini sudah dikembangkan sejak tahun 2001 dan menjadi format file baru guna menampilkan grafik maupun pada pengembangan web yang memiliki XML (eXtensible Markup Language). Keunggulannya, dalam SVG memperbolehkan 3 tipe obyek grafis, diantaranya adalah dalam bentuk vektor grafis seperti jalur yang terdiri dari garis lurus serta kurva, gambar maupun teks. Selain itu, hasil tampilan dari ekstensi ini bisa juga menjadi lebih interaktif dan dinamis 3D. Bahkan efek animasi bisa ditimbulkan dengan menggunakan skripting.

	Ada beberapa keunggulan lain Scalable Vector Graphics, diantaranya adalah ukuran file sumber SVG yang bisa lebih kecil atau bahkan bisa dikompresi tanpa mengalami degradasi signifikan dari segi kualitas dibanding dengan format gambar bitmap sekelas JPEG dan GIF. SVG kompatibel dengan program JAVA, dan gambar memungkinkan bisa dicetak dengan kualitas tinggi serta sama baiknya pada beragam resolusi. Scalable Vector Graphics dapat digunakan pada program Adobe Illustrator, Adobe GoLive dan juga Corel yang memiliki salah satu program pendukung SVG.

	1.3.3 CDR
	Ekstensi ini merupakan ekstensi atau format file berbasis grafik vektor bawaan dari program CorelDraw. Ada keunggulan gambar yang menggunakan ekstensi .cdr, jika dilakukan zoom-in atau diperbesar serta zoom-out atau diperkecil melebihi resolusi dipastikan tidak akan mengalami distorsi atau pecah. Inilah juga yang membuat CorelDraw sangat populer dijadikan program editing grafis vektor. Namun selain CDR digunakan pada CorelDraw, 
	
	1.3.4 AI
	Ekstensi ini merupakan format file grafik berbasis vektor yang langsung didesain oleh perusahaan Adobe sebagai format standar. Gambar yang berekstensi .ai memiliki beberapa keunggulan, diantaranya adalah jika diperbesar maupun diperkecil tidak akan mengalami pecah citra maupun distorsi. Hampir sama dengan format CDR. Namun, file dengan format AI akan memiliki ukuran (size) cukup besar, dan harus dilakukan kompresi untuk memperkecil. Selain beberapa format file grafis vektor diatas, masih ada pula ekstensi yang lainnya seperti Windows Metafile Format, Data eXchange File, Computer Graphics Metafile, Pattern File dan masih banyak lagi yang lain. Masing-masing memiliki keunggulan dan kompabilitas dengan program pengolah grafis vektor yang ada.

	1.3.5 PSD (Photoshop Document)
	Format file ini merupakan format asli dokumen Adobe Photoshop. Format ini mampu menyimpan informasi layer dan alpha channel yang terdapat pada sebuah gambar, sehingga suatu saat dapat dibuka dan diedit kembali. Format ini juga mampu menyimpan gambar dalam beberapa mode warna yang disediakan Photoshop.

	1.3.6 BMP (Bitmap Image)
	Format file ini merupakan format grafis yang fleksibel untuk platform Windows sehingga dapat dibaca oleh program grafis manapun. Format ini mampu menyimpan informasi dengan kualitas tingkat 1 bit samapi 24 bit. Kelemahan format file ini adalah tidak mampu menyimpan alpha channel serta ada kendala dalam pertukaran platform. 

	1.3.7 EPS (Encapsuled Postcript)
	Format file ini merupakan format yang sering digunakan untuk keperluan pertukaran dokumen antar program grafis. Selain itu, format file ini sering pula digunakan ketika ingin mencetak gambar. Keunggulan format file ini menggunakan bahasa postscript sehingga format file ini dikenali oleh hampir semua program persiapan cetak. Kelemahan format file ini adalah tidak mampu menyimpan alpha channel, sehingga banyak pengguna Adobe Photoshop menggunakan format file ini ketika gambar yang dikerjakan sudah final. Format file ini mampu menyimpan gambar dengan mode warna RGB, CMYK, Lab, Duotone, Grayscale, Indexed Color, serta Bitmap. Selain itu format file ini juga mampu menyimpan clipping path.

	1.3.8 JPG/JPEG (Joint Photographic Expert Group)
	Format file ini mampu mengkompres objek dengan tingkat kualitas sesuai dengan pilihan yang disediakan. Format file sering dimanfaatkan untuk menyimpan gambar yang akan digunakan untuk keperluan halaman web, multimedia, dan publikasi elektronik lainnya. Format file ini mampu menyimpan gambar dengan mode warna RGB, CMYK, dan Grayscale. Format file ini juga mampu menyimpan alpha channel, namun karena orientasinya ke publikasi elektronik maka format ini berukuran relatif lebih kecil dibandingkan dengan format file lainnya. JPEG adalah metode standar yang digunakan dalam pengkompresian untuk photograpics images. JPEG singkatan dari Join Photographics Expert Group sebuah kelompok yang membikin standar pengkompresian tersebut. JPEG di buat untuk loosy compression images. Umumnya file file yang berformat JPEG mengunakan extensi .jpeg, .jpg, .jpe, .jfif, jif. Selain itu JPEG juga mampu memberikan warna dengan kedalaman 24 Bits atau setara dengan 16 juta warna. JPEG tidak ditujukan dalam urusan file audio.  Format JPEG (Joint Photographic Expert Group) adalah salah satu alternatif selanjutnya yang dapat kita pakai untuk memperoleh sebuah hasil yang memuaskan. Kelebihan dari format JPEG  adalah :
· dukungan warna yang lebih dari 16 juta atau 24 bit, sehingga hasil yang maksimal dari sebuah gambar dapat diperoleh 
· fitur kompresi kualitas gambar yang ditawarkan membuat saya dapat memilih besar kecilnya file gambar yang akan dihasilkan nantinya dan 
· tersedianya fitur Progressive JPEG, yang mirip seperti interlacing pada GIF. 

	1.3.9 GIF (Graphic Interchange Format)
	Format file ini hanya mampu menyimpan dalam 8 bit (hanya mendukung mode warna Grayscale, Bitmap dan Indexed Color). Format file ini merupakan format standar untuk publikasi elektronik dan internet. Format file mampu menyimpan animasi dua dimensi yang akan dipublikasikan pada internet, desain halaman web dan publikasi elektronik. Format file ini mampu mengkompres dengan ukuran kecil menggunakan kompresi LZW. Format GIF (Graphic Interchange Format) merupakan format file yang paling banyak disarankan dan digunakan. Kelebihan Format ini antara lain adalah : 
· ukuran file yang dihasilkan relatif kecil 
· mampu menggabungkan beberapa gambar menjadi satu kesatuan dan menampilkannya secara bergantian (animasi) 
· warna latar belakang dapat dibuat transparan dan 
· adanya teknologi interlacing yang akan membuat sebuah file di load secara utuh dengan kualitas yang ditampilkan secara bertahap. 

	1.3.10 TIF (Tagged Image Format File)
	Format file ini mampu menyimpan gambar dengan kualitas hingga 32 bit. Format file ini juga dapat digunakan untuk keperluan pertukaran antar platform (PC, Machintosh dan Silicon Graphic). Format file ini merupakan salah satu format yang dipilih dan sangat disukai oleh para pengguna komputer grafis terutama yang berorientasi pada publikasi (cetak). Hampir semua program yang mampu membaca format file bitmap juga mampu membaca format file TIF.
	
	1.3.11 PCX
	Format file ini dikembangkan oleh perusahaan bernama Zoft Cooperation. Format file ini merupakan format yang fleksibel karena hampir semua program dalam PC mampu membaca gambar dengan format file ini. Format file ini mampu menyimpan informasi bit depth sebesar 1 hingga 24 bit namun tidak mampu menyimpan alpha channel. Format file ini mampu menyimpan gambar dengan mode warna RGB, Grayscale, Bitmap dan Indexed Color

	1.3.12 PDF (Portable Document Format)
	Format file ini digunakan oleh Adobe Acrobat, dan dapat digunakan oleh grafik berbasis pixel maupun vektor. Format file ini mampu menyimpan gambar dengan mode warna RGB, CMYK, Indexed Color, Lab Color, Grayscale dan Bitmap. Format file ini tidak mampu menyimpan alpha channel. Format file ini sering menggunakan kompresi JPG dan ZIP, kecuali untuk mode warna Bitmap yaitu menggunakan CCIT.

	1.3.13 PNG (Portable Network Graphic)
	Format file ini berfungsi sebagai alternatif lain dari format file GIF. Format file ini digunakan untuk menampilkan objek dalam halaman web. Kelebihan dari format file ini dibandingkan dengan GIF adalah kemampuannya menyimpan file dalam bit depth hingga 24 bit serta mampu menghasilkan latar belakang (background) yang transparan dengan pinggiran yang halus. Format file ini mampu menyimpan alpha channel. Format PNG (Portable Network Graphic), Adapun beberapa kelebihan dari format tersebut adalah,
· punya semua kelebihan GIF, kecuali animasi 
· fitur Interlacing 2 dimensi yang terbukti lebih baik jika dibandingkan dengan interlacing milik GIF 
· tersedianya 2 format file yaitu PNG8 (256 warna) dan PNG24 yang membuat desainer dapat lebih leluasa memilih kualitas gambar dan 
· teknik kompresi lossless yang digunakan akan menghasilkan ukuran file yang kecil dengan tidak mengalami penurunan kualitas gambar, bandingkan dengan JPEG yang menggunakan teknik kompresi lossy yang dipastikan akan membuat kualitas gambar menurun.

	1.3.14 PIC (Pict)
	Format file ini merupakan standar dalam aplikasi grafis dalam Macintosh dan program pengolah teks dengan kualitas menengah untuk transfer dokumen antar aplikasi. Format file ini mampu menyimpan gambar dengan mode warna RGB dengan 1 alpha channel serta Indexed Color, Grayscale dan Bitmap tanpa alpha channel. Format file ini juga menyediakan pilihan bit antara 16 dan 32 bit dalam mode warna RGB.

	1.3.15 TGA (Targa)
	Format file ini didesain untuk platform yang menggunakan Targa True Vision Video Board. Format file ini mampu menyimpan gambar dengan mode warna RGB dalam 32 bit serta 1 alpha channel, juga Grayscale, Indexed Color, dan RGB dalam 16 atau 24 bit tanpa alpha channel. Format file ini berguna untuk menyimpan dokumen dari hasil render dari program animasi dengan hasil output berupa sequence seperti 3D Studio Max.

	1.3.16 IFF (Interchange File Format)
	Format file ini umumnya digunakan untuk bekerja dengan Video Toaster dan proses pertukaran dokumentasi dari dan ke Comodore Amiga System. Format file ini dikenali hampir semua program grafis yang terdapat dalam PC serta mampu menyimpan gambar dengan mode warna Bitmap. Format file ini tidak mampu menyimpan alpha channel.

	1.3.17 SCT (Scitex Continous Tone)
	Format file ini digunakan untuk menyimpan dokumen dengan kualitas tinggi pada komputer Scitex. Format file ini mampu menyimpan gambar dengan mode warna RGB, CMYK, dan Grayscale namun tidak mampu menyimpan alpha channel.

	1.3.18 PXR (Pixar) 
	Format file ini khusus untuk pertukaran dokumen dengan Pixar Image Computer. Format file ini mampu menyimpan gambar dengan mode warna RGB dan Grayscale dengan 1 alpha channel.
	
	1.3.19 RAW
	Format file ini merupakan format file yang fleksibel untuk pertukaran dokumen antar aplikasi dan platform. Format file ini mampu menyimpan mode warna RGB, CMYK, dan Grayscale dengan 1 alpha channel serta mode warna Multichannel, Lab Color dan Duotone tanpa alpha channel.

	1.3.20 DCS (Dekstop Color Separation)
	Format file ini dikembangkan oleh Quark dan merupakan format standar untuk .eps. Format ini mampu menyimpan gambar dengan mode warna Multichannel dan CMYK dengan 1 alpha channel dan banyak spot channel. Format file ini mampu menyimpan clipping path dan sering digunakan untuk proses percetakan (publishing). Ketika menyimpan file dalam format ini maka yang akan tersimpan adalah 4 channel dari gambar tersebut dan 1 channel preview.

1.4 Implementasi grafis berbantu komputer dalam dunia nyata
	Implementasi grafis dengan komputer ini sangat sering dijumpai dalam kehidupan sehari-hari. Untuk itu pemilihan software yang tepat akan sangat membantu menciptakan bentuk-bentuk objek dengan realisme nyata. Adapun perbedaan grafik komputer dan pengolahan citra. Grafik komputer adalah ilmu yang mempelajari tentang suatu objek gambar. Sedangkan pengolahan citra adalah mengolah sebuah citra lama sehingga menjadi citra baru. Contoh Grafik komputer dalam kehidupan sehari – hari :
	1.Bidang hiburan, misalkan pada film,grafik komputer menghasilkan efek animasi yang baik.
                   [image: https://zaenalafandi.files.wordpress.com/2012/09/transformer11.jpg?w=300&h=240]
Gambar 1.2. Penerapan Grafis dalam Film 3D Transformer

	2.Bidang Pendidikan, grafik komputer pada pendidikan digunakan untuk mempresentasikan objek-objek pada siswa secara nyata, dapat melalui power point ataupun software lainnya.
                          [image: https://zaenalafandi.files.wordpress.com/2012/09/presentasi-bill-gates-4-re.jpg?w=300&h=199]
Gambar 1.3. Pemaparan data dengan menggunakan aplikasi komputer grafis

	3 Digital Art / Seni Digital, Digital Art adalah penggunaan komputer grafis untuk menghasilkan karya-karya seni. Hasil dapat berupa kartun, potret, foto, layout media cetak, logo, lukisan abstrak, desain interior atau eksterior, dan lain sebagainya. Contoh: Adobe Photoshop, Corel Painter, GIMP.  
            [image: https://zaenalafandi.files.wordpress.com/2012/09/index.png?w=285&h=300]
Gambar 1.4. Pembuatan visualisasi desain karakter Animasi dengan menggunakan program komputer grafis.

	4. Video Game adalah permainan yang melibatkan interaksi dengan user interface untuk menghasilkan umpan balik berupa visualisasi pada perangkat video. Aplikasi banyak beredar di pasaran mulai yang sederhana 2 dimensi, seperti tetris, hingga yang rumit, 3 dimensi, 

                                 [image: https://zaenalafandi.files.wordpress.com/2012/09/indexfdf.png?w=300&h=226]
Gambar 1.5. Pembuatan visualisasi Video Game  dengan menggunakan program komputer grafis.

	5. Computer-Aided Design (CAD) adalah alat bantu berbasis komputer yang digunakan dalam proses analisis dam desain, khusunya untuk sistem arsitektural dan engineering. CAD banyak digunakan dalam mendesain bagunan, mobil, pesawat, komputer, alat-alat elektronik, peralatan rumah tangga, dan berbagai produk lainnya.

                  [image: https://zaenalafandi.files.wordpress.com/2012/09/t.png?w=300&h=215]
Gambar 1.6. Aplikasi CAD dalam keseharian

	6. Virtual Reality  adalah lingkungan virtual yang seakan-akan begitu nyata di mana user dapat Berinteraksi dengan objek-objek dalam suasana atau lingkungan 3 dimensi. Perangkat keras khusus digunakan untuk memberikan efek pemadangan 3 dimensi dan memampukan user beriteraksi dengan objek-objek yang ada dalam lingkungan. 

                           [image: ::Downloads:herrenknecht-implements-ic.jpg]  
Gambar 1.7. Aplikasi Virtual Reality dalam menganalisa produk
 
	7. Visualisasi Data adalah teknik-teknik membuat  citra, diagram, atau animasi untuk mengkomunikasikan pesan. Visualisasi telah menjadi cara yang efektif dalam mengkomunikasikan baik data atau ide abstrak maupun nyata sejak permulaan manusia. Contoh: visualisasi dari struktur protein, strutur suatu website, visualisasi hasil data mining, dapat digunakan untuk pemotretan lewat satelit, GPS, foto kamera dan lain-lain
                  [image: https://zaenalafandi.files.wordpress.com/2012/09/8_kk_karam.jpg?w=300&h=206]
Gambar 1.8. pemanfaatan GPS melalui Komputer Grafis.

1.5 Soal dan Jawab
	1. Bagaimana peranan Komputer Desain dalam industri kreatif di era 	teknologi digital sekarang ini?
	Jawab : Peranan Komputer Desain sangat Vital dalam alur kerja para pekerja 	citra agar terlihat menarik, kuat dan berkarakter, Komputer Desain di era 	teknologi digital adalah merupakan salah satu elemen kunci untuk 	secara 	global.

	2. Sebutkan minimal 2 program aplikasi yang digunakan untuk mengolah 	gambar vektor dan bitmap!
	Jawab : Vektor :  Corel Draw, Adobe Ilustrator
		 Bitmap : Corel PhotoPaint, Adobe Photoshop

	3. Sebutkan ada berapa macam tipe grafik dalam Komputer !
	Jawab : ada 2 macam yaitu; Grafik Komputer tipe Vektor yaitu pembuatan 	citra/gambar dengan berdasarkan pembuatan kurva dan garis lurus serta tipe 	Bitmap yaitu pembuatan citra/gambar dengan berdasarkan atas titik penyusun 	gambar.

1.5 Soal-soal
	1. Apa definisi Komputer desain dan bagaimana perkembangannya?
	2. Sebutkan macam-macam program aplikasi pengolah gambar tipe grafik 	Bitmap yang anda ketahui!
	3. Sebutkan macam-macam program aplikasi pengolah gambar tipe grafik 	Vektor yang anda ketahui!
	4. Sebutkan 3 macam kegunaan komputer grafis dalam implementasinya 	sehari-hari!
	5. Jelaskan perbandingan grafik vektor dan Bitmap!

1.6 Lampiran : -
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Bab 2
Operasional Dasar Aplikasi Grafis Adobe Illustrator

a. Kompetensi Dasar dan Indikator
· Kompetensi Dasar :
Setelah menyelesaikan pokok bahasan Operasional Dasar Aplikasi Grafis Adobe Illustrator mahasiswa terampil dalam bekerja dan menguasai teknologi Komputer Desain melalui ilustrasi grafis yang diterapkan pada produkuntuk meningkatkan nilai dari desain yang dibuat melalui aplikasi program Adobe Illustrator.
· Indikator :
1. Mengetahui dan memahami program Adobe Illustrator.
2. Mengetahui dan memahami bagaiamana menjalankan Program Adobe Illustrator dan membuat  lembar kerja program Adobe Illustrator.
3. Mengetahui dan memahami cara membuat transformasi objek geometri sederhana
4. Mengetahui dan memahami cara membuat objek dengan teknik Trace

b. Pokok Bahasan : Mengenal dan Operasional Dasar Aplikasi Grafis Adobe Illustrator

c. Sub Pokok Bahasan : 
· Mengenal program Adobe Illustrator
· Menjalankan Program Adobe Illustrator dan membuat lembar kerja Program Adobe Illustrator
· Membuat transformasi objek geometri sederhana
· Membuat Objek dengan menggunakan teknik Trace

d. Estimasi Waktu : 4 x 45 menit

e. Media Pembelajaran : LCD projector, Komputer dan Graphic Tablet



2.1 Mengenal program Adobe Illustrator
	Adobe Illustrator adalah software grafis yang dikembangkan oleh Adobe Inc. Software ini dikembangkan pertama kali pada tahun 1986 dan dirilis tahun 1988. Software grafis berbasis vector ini adalah produk yang dibuat untuk mendampingi Adobe Photoshop. Kalau Adobe Photoshop lebih sering digunakan untuk manipulasi foto digital dan gaya photorealistic ilustrasi komputer, Adobe Illustrator lebih terarah pada bidang penyusunan huruf dan desain logo grafis.

                       [image: engenal definisi Adobe Illustrator, sejarah dan versi yang sudah dikeluarkan oleh Adobe Inc.]
Gambar 2.1. Logo Aplikasi Adobe Illustrator

Sejak dirilis pertama kali pada tahun 1988, hingga sekarang Adobe Ilustrator telah mengeluarkan 16 versi, diantaranya :
1. Versi 1-1,6 (Illustrator 88)
	Versi pertama dari Adobe Illustrator dikembangkan untuk Apple Macintosh di tahun 1986 (pengiriman pada bulan Januari 1987) sebagai komersialisasi software font development Adobe PostScript dan format file.

2. Versi 2-5
	Selama sepuluh tahun pertama Adobe Illustrator mengembangkan produknya untuk Macintosh, akhirnya pada awal 1990, Adobe merilis versi dari Illustrator untuk NeXT , Silicon Graphics , dan Platform Sun Solaris. Namun hal itu dihentikan karena respon pangsa pasar yang rendah. Versi pertama Illustrator untuk Windows sendiri dirilis pada tahun 1989, Versi 2.2. Versi Illustrator untuk Windows selanjutnya, versi 4.0,  banyak dikritik karena dianggap mirip dengan Illustrator 1.1 bukannya Illustrator untuk Macintosh versi 3.0. Hal itu diperparah dengan produk grafis yang sedang popular untuk Windows saat itu, yaitu CorelDraw. Namun begitu, versi 4 adalah versi pertama yang mendukung pengeditan dan modus pratinjau, yang bahkan tidak muncul di Macintosh hingga tahun 1993.

3. Versi 6-10
	Untuk vversi ini yang telah diperkenalkan pada tahun 1996, sudah bayak sekali mengalami perubahan untuk diserupakan dengan  user interface yang ada pada Adobe Photoshop. User lebih memilih  tidak memperbaharui versi ini. Selain user interface, Illustrator juga sudah support dengan beberapa plugin seperti halnya Adobe Photoshop.

4. Versi CS-CS5
	Illustrator CS adalah versi pertama produk grafis pertama Adobe yang menyertakan kemampuan 3D yang memungkinkan pengguna membuat dan mengedit bentuk sederhana obyek 3 Dimensi. Illustrator CS2 (Versi 12) tersedia untuk sistem operasi Mac OS X dan Microsoft Windows. Versi ini menyajikan fitur baru, yaitu Live Trace, Live Paint, palet Custom Control dan Worksheet. Illustrator CS3 menampilkan kebaruan interface pada Bar Control, panel panduan warna dan fitur Live Color lainnya. CS4, dirilis bulan Oktber 2008. Versi ini dibekali fitur yang dirombak dari tool-tool lama dengan tool baru dari FreeHand. FreeHand menambah kemapuan untuk menciptakan beberapa artboards, ini memungkinkan pengguna untuk membuat beberapa versi pada pekerjaan dalam satu dokumen. Fitur lain yang ditambahkan dalam versi CS4 ini adalah Brush Blob, yang bisa membuat stroke brush yang saling tumpang tindih bisa digabungkan. Dan ada juga tool Gradient Revamped yang memperdalam manipulasi warna serta transparansi dalam gradasi warna. Dirilis pada bulan April  2010, CS5 hadir dengan fitur tool Perspektif Grid yang diperoleh dari FreeHand, Sebuah brush, yang mampu menampilkan stroke tampak alami.

5. Versi CS6
	Adobe Illustrator CS6 adalah generasi ke enam belas yang menambahkan lebih banyak fitur dan perbaikan pada bug.

Kelebihan  Program Adobe Illustrator
1. Mudah diintegrasikan dengan software Adobe yang lain.
2. Untuk pengerjaan ilustrasi sangat powerful dan ringan.
3. Fitur lengkap, seperti palet layar di Adobe Photoshop yang sering digunakan desainer grafis untuk mengkoordinasi layar.
4. Memiliki beberapa efek yang ada di photoshop.
5. Dapat membuka file-file besar, tanpa ada gejala lag.
6. Kualitas warnanya sangat baik, warna output di monitor dengan print outnya hampir mendekati sama.
7. Warna tampilan interface yang menarik, apalagi Adobe Illustrator CS 6 keluar dengan tampilan baru warna hitam yang menambah kesan sangar pada produk Adobe tersebut.

2.2 Menjalankan Program Adobe Illustrator dan membuat lembar kerja Program Adobe Illustrator.
	Teknik pertama adalah membuat sebuah dokumen baru serta menentukan parameter penyusunnya. Untuk itu ikuti langkah-langkah berikut ini. Jika Anda membuka program illustrator pertama kali, maka secara default sebuah kotak dialog Welcome Screen akan ditampilkan. Jika kotak ini tidak tampil, Anda bisa mengaktifkannya dengan memilih menu Help > Welcome Screen. Lihat Gambar 2.2. Melalui kotak dialog Welcome Screen ini, klik ikon New Document.Cara kedua adalah dengan memilih menu File > New, atau cukup dengan menekan tombol Ctrl + N pada keyboard         
		                 [image: dobe Illustrator CS]

Gambar 2.2. Kotak dialog Welcome Screen
	Pergi File> New Document untuk membuat dokumen pertama. Ketik Nama untuk dokumen dan klik Advanced untuk memilih RGB untuk warna Modus seperti yang akan dikerjakan untuk layar. Klik Ok setelah itu. 
                         [image: okumen baru]
Gambar 2.3. Kotak dialog New Document

	Adobe Illustrator Workspace (Area Kerja)
	[image: llustrator's Work Area]

	


Gambar 2.4. Area kerja dalam program

	Area kerja dari aplikasi Illustrator pada dasarnya terdiri atas beberapa komponen, antara lain:
1. Menu Bar : Berupa barisan yang berisi kontrol untuk berbagai fungsi seperti membuat, membuka, menyimpan file, ekspor dan sebagainya sesuai dengan menu yang ditampilkan.
2. Artboarts : Adalah area persegi empat yang merupakan tempat untuk membuat dan mengerjakan obyek.
3. Tool Box : Berisi menu untuk membuat atau menggambar bentuk, memberi pewarnaan, dsb.
4. Color Pallates : Berisi warna-warna yang dipakai dalam pewarnaan objek di dalam Adobe Illustrator.
5. Objek Properties : Berisi tentang informasi objek antara lain koordinat objek, rotation, fill, stroke, width, height, dsb.
6. Layer Properties : Berisi layer-layer dimana objek berada (sama seperti di Potoshop).
7. Status Bar :  Baris yang menampilkan informasi objek yang sedang dikerjakan, jumlah halaman, dsb.
8. Scroll Bar : Penggulung area kerja ke kiri-kanan atau atas-bawah.

	Berikut adalah ruang kerja standar dan beberapa istilah umum untuk menyebutnya. Jika menggunakan Adobe Illustrator CS3, maka terlihat desain baru untuk  Floating Palette.

                       [image: ntarmuka ilustrator]
Gambar 2.5. Area kerja standar 


Toolbox 
	Fitur ini berada satu kolom tunggal seperti yang ditunjukkan pada gambar di atas. Untuk beralih kembali ke yang lama toolbox 2 kolom, Anda dapat mengklik kiri atas Mini panah untuk beralih ke 2 kolom. Beberapa alat seperti Rectangle memiliki alat yang lebih tersembunyi. Untuk memperluas, cukup klik dan tahan ikon untuk mengungkapkan semua alat serupa di bawah kelompok itu. 

[image: lustrator toolbox]Gambar 2.6. Area toolbox

Palet Kerja Mengambang
	Palet ini berisi properti dan berbagai tools untuk membuat dan mengedit objek berdasarkan garis, simbol, Gradasi, Palet warna standar , layer (Lapisan bidang kerja). Palet ini memberikan efek agar hasil objek desain dapat bertransformasi secara otomatis dalam membentuk estetika sesuai dengan tools.
                      [image: lustrator mengambang palet]

Gambar 2.7. Area palet kerja mengambang (Floating pallete box)

Menyimpan AI File 
	Pilih jenis dan klik pada artboard dan ketik beberapa teks untuk penamaan file. Setelah itu pergi ke File> Simpan. Pilih Adobe Illustrator (*. AI) untuk jenis file dan beri nama "Gambar 1". Klik Ok setelah itu. Meninggalkan sisa pengaturan di default.  Illustrator CS menawarkan 2 (dua) mode warna yang paling umum digunakan, yaitu CMYK (Cyan-Magenta-Yellow-Black) dan RGB (Red-Green-Blue). Pemilihan mode warna ditentukan oleh tujuan akhir penggunaan desain dalam dokumen bersangkutan, dimana jika desain tersebut ditujukan untuk kepentingan cetak, sebaiknya gunakan mode warna CMYK, sementara jika digunakan untuk kepentingan tampilan di monitor, pakailah mode warna RGB. Setelah menentukan semua parameter pengaturan dokumen, klik tombol Ok dan dokumen kerja baru siap untuk digunakan. 

2.3 Membuat transformasi objek geometri sederhana
	Transformasi Istilah berasal dari akhir kata latin "transformasi" (metamorfosis). Transformasi obyek biasanya mengubah posisi atau bentuk, atau keduanya. Tentu saja, tampak jelas dan cukup mudah, tapi operasi sederhana ini mampu mengubah gambar secara drastis. Ada banyak jenis transformasi mengubah berbagai parameter (posisi, ukuran, sudut, dll), mereka dapat dilakukan baik secara terpisah atau bersama-sama pada waktu yang sama. Transformasi berlaku untuk salah satu atau lebih objek yang sudah dipilih dengan Selection Tool (V). 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/1.jpg]
Gambar 2.8. Transformasi bentuk sederhana

Bounding box 
	Objek dalam dokumen memiliki bentuk yang beragam, tetapi algoritma transformasi berlaku untuk semua. Hal ini karena program ini memiliki sistem terpadu transformasi,  Perbatasan menyentuh paling kiri, paling kanan, paling atas, dan bawah-poin terbanyak dari suatu objek. Ini mencakup empat titik sudut dan empat sisi, sama pentingnya dalam transformasi. Sudut objek memungkinkan merubah objek menjadi bentuk yang lain, tekan (Shift + Command + B) untuk mengaktifkan perintah Bounding box. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/2.jpg]
Gambar 2.9. Area bounding box pada objek

Transformasi Poin
	Sudut objek biasanya mencakup titik sentral yang menunjukkan titik pusat dari sebuah objek. Secara default, titik pusat ini suatu benda dianggap sebagai titik transformasi, atau titik referensi. Ini berarti, bahwa ketika suatu objek misalnya diubah ukurannya, pusat akan tetap di tempat, sementara semua titik lainnya mengubah posisi. Namun, saat melakukan transformasi jalur sudut kemiringan objek juga dapat diubah. Dalam hal ini titik yang baru dipilih (dalam kaitannya dengan bentuk awal dari sebuah objek) akan tetap di tempat. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/3.jpg]
Gambar 2.10. Transformasi poin

Pindah 
	Jenis utama dari transformasi bergerak. Memindahkan obyek berarti mengubah koordinat, sehingga posisi diubah.Maka, bergerak adalah mengubah.  Ini adalah cara yang paling populer untuk transformasi objek. Pindah biasanya didasarkan pada titik pusat dari suatu objek, dan titik transformasi tidak berubah. Pindah diukur dalam poin, piksel, atau unit jarak lain yang diatur dalam Preferensi (Command + K). 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/4.jpg]
Gambar 2.11. Transformasi perpindahan

Scaling 
	Scaling adalah mengubah ukuran suatu objek. Ada banyak cara untuk skala objek di Illustrator, tetapi mereka semua mengubah ukuran suatu objek. Setiap titik transformasi dapat ditugaskan sementara skala. Pada grafik dua dimensi ada dua sumbu, sehingga objek dapat ditingkatkan dalam dua arah.  Hal ini dimungkinkan untuk skala itu secara terpisah (horizontal atau vertikal) - dalam hal ini bentuk dan proporsi objek akan berubah. Skala proporsional akan membatasi bentuk objek, mengubah secara bersamaan dalam dua arah. Scaling diukur dalam persen, mulai dari 100% sebagai ukuran objek awal. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/5.jpg]
Gambar 2.12. Transformasi Scaling / Skala

Rotating 
	Transformasi Rotating adalah berputar mengubah sudut objek. Putaran objek sangat bervariasi dari 0 hingga 360 derajat, prosesnya adalah perpindahan putaran objek dari posisi awal pada imajiner lingkaran virtual. Tergantung pada titik transformasi yang ditetapkan, diameter lingkaran maya ini dapat diubah. Jika  meninggalkan titik transformasi di tengah kotak sudut objek, maka objek akan berputar di sekitar itu sendiri. Ada banyak cara untuk memutar objek, memasuki sudut diperlukan. Rotasi diukur dalam derajat dari -360 sampai 360. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/6.jpg]Gambar 2.13. Transformasi Rotating (Berputar)



Mirroring / Cerminan (membalik objek)
	 Mirroring adalah membalik objek ke segala arah, mencerminkan itu dari sumbu yang dibutuhkan. Perubahannya ada pada flip obyek secara vertikal maupun horizontal, atau memasukkan setiap sudut lainnya.  
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/7.jpg]
Gambar 2.14. Transformasi Mirroring (Cerminan)
Shearing / Geser
	Shearing adalah transformasi geser. Objek akan begeser dengan kemiringan salah satu sudut. Kemiringan ini bervariasi dari sumbu horisontal atau vertikal untuk setiap sudut. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/8.jpg]
Gambar 2.15. Transformasi Shearing (Bergeser)

Free Transform (Transformasi bebas)
	Jenis transformasi terakhir adalah free transform, metode ini memungkinkan untuk secara bebas mengubah objek dengan beberapa parameter sekaligus. Ini berarti bahwa posisi, ukuran, sudut, dan kemiringan dapat diubah secara bersamaan, menggabungkan beberapa jenis transformasi dalam satu bentuk. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/9.jpg]
Gambar 2.16. Free Transform (Transformasi bebas)



Menggunakan  tools Transform 
	Cara lain yang dalam penerapan transformasi objek adalah menggunakan peralatan dari panel Tools. Ada beberapa alat transformasi yang mengubah parameter yang berbeda dari objek yang dipilih, dengan menggunakan tools transform maka hasil yang didapatkan akan jauh lebih presisi karena bisa diedit sudut dan poinnya secara pasti.

Move / Pindah 
	Move Tool (V) dikombinasikan dengan Selection Tool dan menyajikan panah hitam akrab. Cara termudah bergerak adalah, sebenarnya, memindahkan objek yang dipilih secara manual dengan menyeretnya ke posisi yang diinginkan. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/10.jpg]
Gambar 2.17. Transformasi move (pindah)

Scale / Skala 
	 Scale Tool (S) digunakan untuk merubah skala objek yang dipilih, cukup tarik pegangan kotak berlari nya (delapan kotak putih). Untuk skala horisontal, tarik horizontal, dan untuk skala vertikal, tarik vertikal. Untuk keduanya, tarik bagian tengah, dan untuk membatasi proporsi tekan tombol Shift. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/11.jpg]
Gambar 2.18. Transformasi Scale
Rotate / Putar
	Rotate Tool (R) adalah transformasi berputar. Untuk memutar objek, pilih dan tarik ke arah yang diperlukan. Sebagai titik transformasi default adalah di pusat objek, akan diputar disekitar objek itu sendiri. Sudut yang diputar pun beragam mulai dari -360 hingga 360 derajat.
 [image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/12.jpg]
Gambar 2.19. Transformasi rotate (berputar)

Reflect / Cerminan
	Reflect Tool (O) adalah tools untuk mencerminkan objek yang dipilih, dengan menarik ke arah yang dituju. Titik referensi default adalah di tengah, sehingga objek akan tercermin di sekitar sumbu yang memotong pusat objek. Untuk menggunakan dengan tempat maka harus berpanduan dengan sumbu horisontal atau vertikal dengan menekan tombol Shift. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/13.jpg]
Gambar 2.20. Transformasi reflect (cerminan)

Shear 
	Shear adalah tools tampak seperti persegi panjang miring  dan terdapat di bawah Tool Scale. Berfungsi untuk menggeser sudut objek yang dipilih dan menempatkannya dimanapun dalam bidang kerja. 
[image: https://cdn.tutsplus.com/vector/uploads/legacy/tuts/000_2010/288_Illustrator_Transformations/14.jpg]
Gambar 2.21. Transformasi Shear (bergeser)

2.4 Membuat Objek dengan menggunakan teknik Trace
	Pertama buka Adobe Illustrator. Buat dokumen kerja baru. Pilih File > New. Buat Dokumen baru, pada kotak dialog New Document pilih setting di bawah ini.

[image: ikin Dokumen Baru]
Gambar 2.22. Kotak dialog Welcome Screen

[image: otak Dialog New Document]
Gambar 2.23. Kotak dialog New Documemt

	Kemudian klik Ok dan  dokumen kerja baru akan muncul seperti berikut.
[image: okumen Kerja Baru] 
Gambar 2.24. Dokumen Kerja Baru
 
	Setelah membuat dokumen kerja baru, langkah berikutnya adalah memasukkan gambar/image yang akan ditracing. Sebagai contoh gambar yang digunakan adalah image Soekarno. Gunakan foto yang digunakan berukuran besar. Karena semakin besar dimensi foto, semakin mudah untuk ditrace. Pilih menu File > Place. Lihat Gambar berikut.
                  [image: enu Place]
Gambar 2.25. Kotak dialog file
 
	Di kotak dialog Place, pilih file image/foto yang akan ditracing. Pastikan untuk mengaktifkan pilihan Link. Simak Gambar di bawah ini.

[image: otak dialog Place]
Gambar 2.26. Kotak dialog place

	Klik Place dan image tadi akan masuk ke dalam dokumen kerja 
[image: mage di dokumen kerja]
Gambar 2.27. Image di dokumen kerja

	Jika ukuran image yang masuk tadi tidak memenuhi ruang kerja, maka langkah berikutnya adalah memperbesarnya sehingga seluruh ruang kerja (artboard) kita terpenuhi. Caranya dengan mengklik image, kemudian arahkan kursor mouse ke salah satu ujung image (kotak kecil putih), kemudian sambil menekan tombol Shift + Alt/Option (Macintosh), drag ke arah luar. Image akan diperbesar. Pastikan perbesarannya memenuhi artboard bidang gambar. 

[image: erbesar image sampai memenuhi artboard]
Gambar 2.28. Gambar yang telah diperbesar sesuai artboard

	Langkah berikutnya adalah mengunci layer image tadi sehingga tidak akan teredit secara tak sengaja. Caranya, lihat Palette Layer. Jika belum muncul, maka cara menampilkannya adalah dengan memilih menu Window > Layers, atau tekan tombol F7 di keyboard. Perhatikan bahwa di Palette Layer terdapat Layer 1 dengan icon gambar yang  masuk kedalam dokumen.
                                      [image: alette Layers]
Gambar 2.29. Kotak Pallet Layer

 	Arahkan mouse di antara icon mata & icon gambar, sehingga muncul tulisan “Toogles lock”. Kemudian klik hingga muncul icon kunci (padlock) Lihat Gambar di bawah ini.
                                  [image: unci Layer Image]
Gambar 2.30. Kunci Layer Image

	Image sudah terkunci dan tidak akan teredit secara tak sengaja. Berikutnya adalah membuat sebuah layer baru di atas Layer 1 (image), untuk bekerja mentracing. Caranya arahkan kursor mouse ke ikon Create a new layer [image: https://astayoga.files.wordpress.com/2014/05/screen-shot-2014-05-08-at-9-03-35-pm.png?w=30&h=20]. Sehingga box layer akan mempunyai layer baru di atas Layer 1, bernama Layer 2. Simak Gambar berikut.
                                  [image: ayer baru]
Gambar 2.31. Layer baru

	Pilih menu File > Save As dan isi nama file yang diinginkan di kotak dialog Save As dan tekan Ok. Maka dokumen telah aman tersimpan.

       [image: ave dokumen]
Gambar 2.32. Save Dokumen

Pada toolbar, pilih tool Pen [image: https://astayoga.files.wordpress.com/2014/05/screen-shot-2014-05-08-at-9-35-29-pm.png?w=25&h=22]. Masih di Toolbar, pastikan Fill Color kosong (None)–tidak ada warna aktif, dan Stroke akan berubah menjadi warna terang (jingga). Simak Gambar berikut.
                                   [image: onaktifkan Fill, aktifkan Stroke warna oranye]
Gambar 2.33. Nonaktifkan Fill, aktifkan Stroke warna oranye

	Berikutnya, untuk memudahkan dalam mentracing, perbesar (zoom in) obyek image tadi. Sehingga cukup jelas tekstur yang akan dibuat trace. Caranya dengan menekan tombol Ctrl + (+). Lihat Gambar di bawah ini.

[image: erbesar (Zoom in) gambar]
Gambar 2.34. Perbesar (Zoom in) gambar

	Setelah gambar cukup besar & jelas pastikan tool Pen aktif. Pertama tracing di bagian yang mata. Sebaiknya mentracing foto atau gambar orang dengan mulai dari mata. Dalam contoh akan dimulai dari mata kiri Soekarno. Klik Pen tool di bagian pojok bawah mata, kemudian klik lagi sambil tarik kursor mouse untuk membuat lengkungan atas mata yang diinginkan. Lihat Gambar berikut.

[image: ulai trace mata]
Gambar 2.35. Trace bagian mata

	Perhatikan bahwa ada 2 handler (garis pengaturan lengkungan). Klik di titik kanan untuk menonaktifkan handler kedua, lalu lanjutkan membuat garis lengkung berikutnya mengikuti kontur bentuk mata. Simak Gambar di bawah ini.

[image: onaktifkan handler kedua]
Gambar 2.36. Nonaktifkan handler kedua

	Lanjutkan hingga seluruh bagian mata ditracing dan titik awal bertemu dengan titik akhir tracing. Lihat Gambar ini.

[image: race seluruh bagian mata sesuai kontur]
Gambar 2.37. Trace seluruh bagian mata sesuai kontur

	Setelah membuat trace kontur mata kanan, lanjutkan langkah yang sama di mata yang satunya lagi. Lakukan seperti Step di atas, tentunya dengan mengikuti bentuk kontur mata kiri. Simak Gambar di bawah ini.

[image: anjutkan trace mata kiri]
Gambar 2.38. Trace bagian mata kiri

	Jika mata sudah selesai, lanjutkan dengan tracing bagian-bagian utama lainnya. Seperti alis. Lihat Gambar berikut.

[image: anjutkan trace bagian alis]
Gambar 2.39. Trace  bagian alis

	Lanjutkan di bagian hidung. Ikuti kontur untuk membuat bentuknya. Tidak harus detail dulu, yang penting bentuk dasarnya terlihat.
[image: race kontur hidung]
Gambar 2.40. Trace kontur hidung


	Teruskan di mulut. Serupa dengan hidung, ikuti kontur warna mulut.
[image: race kontur mulut]
Gambar 2.41. Trace bagian kontur mulut

	Untuk mengecek hasil trace sementara, seleksi semua obyek trace tadi dengan menekan tombol Ctrl + A (Windows) atau Command + A (Mac). Kemudian di Toolbar klik Swap Fill and Stroke [image: https://astayoga.files.wordpress.com/2014/05/screen-shot-2014-05-08-at-10-19-07-pm.png?w=13&h=13]untuk merubah warna Stroke oranye menjadi warna Fill. Lihat Gambar berikut ini.

[image: bah warna stroke jadi Fill]
Gambar 2.42. Ubah warna stroke jadi Fill

	Palette Layers non aktifkan Layer 1 (gambar).

[image: onaktifkan Layer 1]
Gambar 2.43. Nonaktifkan Layer 1

	Hasilnya seperti berikut.
[image: asil tracing sementara]
Gambar 2.44. Hasil tracing sementara

	Langkah berikutnya tinggal mengulang langkah-langkah di atas untuk bagian-bagian lain yang ingin ditrace. Seperti rambut, garis wajah, dan sebagainya, sehingga terlihat bentuk tracing yang lebih jelas. Simak Gambar berikut.

[image: race bagian-bagian lain]
Gambar 2.44. Trace bagian-bagian lain



	Hasilnya seperti berikut ini.

[image: asil trace ]
Gambar 2.45. Hasil tracing lanjutan

	Teruskan di bagian-bagian lain, sehingga seluruh bagian yang konturnya jelas berhasil ditrace. Lihat Gambar di bawah ini.

[image: race bagian-bagian lain]
Gambar 2.46. Trace bagian-bagian lain
		
Hasilnya seperti berikut ini.
[image: asil trace keseluruhan]
Gambar 2.47. Hasil tracing final

2.5 Soal dan Jawab
	1. Apa fungsi Pen tool dalam program Adobe Illustrator?
	Jawab : Sebagai alat bantu untuk membuat gambar vektor dengan karakteristik  	poin, garis dan kurva.

	2. Bagaimana membuat objek Lingkaran yang simetris dalam Program Adobe 	Illustrator?
	Jawab : Menggunakan tool elipse, kemudian klik dan tahan tombol [ctrl] agar 	lingkaran yang dibuat menjadi simetris.

	3. Apa fungsi transformasi dalam program Adobe Illustrator?
	Jawab : Fungsi transformasi adalah untuk memindah, mengubah, mengedit 	bentuk dasar objek vektor.

2.6 Soal-soal
	1. Bagaimana proses dalam mentracing sebuah foto?
	2. Sebutkan macam-macam bentuk transformasi dalam program Adobe 	Illustrator!
	3. Tools apa saa yang digunakan dalam mentracing sebuah foto?
	4. Apa fungsi tools layer?
	5. Apa perbedaan format gambar CMYK dan RGB?
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I. 7 Daftar Pustaka 
1.Pujiyanto.2005. Desain Grafis Komputer. Yogyakarta:Penerbit Andi.  
2.MADCOMS.2005. Seri Lengkap Adobe CS. Yogyakarta:Penerbit Andi
3.www.ilmugrafis.com




















Bab 3
Operasional Dasar Aplikasi Grafis Adobe Photoshop

a. Kompetensi Dasar dan Indikator
· Kompetensi Dasar :
Setelah menyelesaikan pokok bahasan Operasional Dasar Aplikasi Grafis Adobe Photoshop mahasiswa terampil dalam bekerja dan menguasai teknologi Komputer Desain melalui ilustrasi grafis yang diterapkan pada produkuntuk meningkatkan nilai dari desain yang dibuat melalui aplikasi program Adobe Photoshop.
· Indikator :
1. Mengetahui dan memahami program Adobe Photoshop.
2. Mengetahui dan memahami bagaimana menjalankan Program dan membuat  lembar kerja program Adobe Photshop.
3. Mengetahui dan memahami cara membuat objek sederhana pada program Adobe Photoshop
4. Mengetahui dan memahami cara render objek realistis dengan teknik digital painting

b. Pokok Bahasan : Mengenal dan Operasional Dasar Aplikasi Grafis Adobe Photoshop

c. Sub Pokok Bahasan : 
· Mengenal program Adobe Photoshop
· Menjalankan Program Adobe Illustrator dan membuat lembar kerja Program Adobe Photoshop
· Membuat objek sederhana pada program Adobe Photoshop
· Membuat objek realistis dengan teknik digital painting
d. Estimasi Waktu : 4 x 45 menit

e. Media Pembelajaran : LCD projector, Komputer dan Graphic Tablet


3.1 Mengenal program Adobe Photoshop
	Adobe Photoshop adalah pengolah grafis raster buatan Adobe Systems, Inc, sebuah perusahaan software terkemuka berbasis di California, Amerika Serikat. Sejak kemunculannya di tahun 1988, Photoshop menjadi standar software pengolah grafis bitmap di dunia.
[image: hotoshop09]
Gambar 3.1. Kotak dialog Welcome Screen

Keunggulan Photoshop
	Berikut adalah beberapa keunggulan utama Photoshop:
· Kelengkapan Fitur & Fasilitas
	Photoshop mempunyai beragam fitur dan fasilitas yang memungkinkan pekerjaan kita menjadi mudah, praktis dan dengan hasil optimal. Fitur utama seperti layer, alpha channel, path, history log, filters, color modes, vector editing hingga kemampuan ekspor ke beragam format file menjadikannya andalan.
· Fleksibilitas Penggunaan
	Penggunaan Photoshop sangat fleksibel. Untuk beragam tipe pekerjaan, User bisa menggunakan beragam tool dan fasilitas yang ada, semisal desain untuk cetak, web, animasi dan sebagainya.

	Selain itu, Photoshop memungkinkan user mengatur sendiri tampilan kerja program dan melakukan kustomisasi menu, shortcut dan sebagainya.

· Integrasi Dengan Program Lain (Adobe)
	Kelebihan lain dari program Adobe Creative Suite (CS), adalah integrasinya yang semakin baik dengan program-program lainnya, utamanya buatan Adobe, seperti Illustrator, InDesign, After Effects dan sebagainya. Sehingga User bekerja di Photoshop, hasilnya bisa digunakan secara fleksibel di pekerjaan lain menggunakan program lain dari Adobe tanpa kehilangan kualitas dan kemampuan editingnya.

[image: hotoshop10]Gambar 3.2. Berbagai Seri Adobe Photoshop

3.2 Menjalankan Program Adobe Illustrator dan membuat lembar kerja Program Adobe Photoshop
	Sejak kemunculannya di tahun 1988, Adobe telah meluncurkan 15 seri Photoshop. Yang terbaru, di tahun 2014, dirilis seri Photoshop CC (Creative Cloud). Seri CC merupakan kelanjutan dari seri Photoshop CS (Creative Suite) yang keluar di tahun 2003 hingga 2013. Seri manapun yang digunakan sebenarnya tidak terlalu masalah. Karena secara esensial, fitur-fitur utama Photoshop yang akan digunakan tidak banyak berubah. Saat membuka program Adobe Photoshop CS, berikut adalah tampilan interface (antarmuka) Adobe Photoshop seri CS.
[image: ampilan antarmuka Photoshop CS3]
Gambar 3.3. Tampilan antarmuka Photoshop CS

Menu Bar
	Menu bar adalah kumpulan menu-menu yang ada di Photoshop. Terdiri dari 10 (sepuluh) menu utama, dan masing-masing di dalamnya terdapat submenu masing-masing. Menu-menu tersebut adalah: File, Edit, Image, Layer, Select, Filter, Analysis, View, Window dan Help.

[image: asilitas Menu Bar]
Gambar 3.4. Fasilitas Menu Bar

	Untuk memunculkan sebuah menu, cukup mengklik menu bersangkutan, dan submenu didalamnya akan muncul. Perhatikan Gambar di atas, Klik pilihan menu Image > Mode > RGB Color.

Perhatikan bahwa di submenu Mode terdapat segitiga hitam di ujung kanannya, ini menunjukkan adanya submenu di dalamnya. Berbeda dengan menu lain seperti Duplicate atau Image Size yang tidak mempunyai submenu. Saat memilih menu, dimungkinkan adanya pilihan tambahan. Pilihan tambahan ini berupa dialog box (kotak dialog), di mana User bisa memasukkan nilai tertentu atau memilih parameter yang ada di dalamnya. Perhatikan contoh dialog box untuk menu Image > Image Size dibawah ini.

[image: ialog box menu Image Size]
Gambar 3.5. Dialog box menu Image Size

Toolbar
Toolbar adalah fasilitas di mana semua tool (alat) kerja berada. Photoshop memberi  beragam tool untuk mengerjakan beragam fungsi, seperti menyeleksi, menggambar, mewarnai, menuliskan teks dan sebagainya. 


[image: asilitas Toolbar ]
Gambar 3.6. Fasilitas Toolbar

	Terdapat beragam tools (alat) dimana kelompok tools ini dikelompokkan menjadi beberapa kategori untuk memudahkan User dalam menggunakannya.
Kelompok tool tersebut adalah:
· Selection tools
	Terdiri dari tool-tool yang bisa digunakan untuk melakukan seleksi area gambar (image), seperti Move tool, Rectangular Marquee tool dan sebagainya.
· Crop and slice tools
	Terdiri dari tool-tool yang bisa digunakan untuk melakukan cropping (pemotongan) area gambar (image) dan slicing (pemotongan area untuk diekspor menjadi halaman web).
· Retouching tools
	Sesuai namanya, kelompok ini terdiri dari tool-tool yang bisa digunakan untuk melakukan retouching (manipulasi) gambar (image). Seperti misalnya menghilangkan warna merah pada mata, menghaluskan kulit  dan lain sebagainya.
· Painting tools
	Terdiri dari tool-tool yang bisa digunakan untuk menggambar (melukis) di Photoshop. Sangat berguna saat Anda melakukan editing foto, atau benar-benar menggambar di Photoshop.
· Drawing and type tools
	Sedikit berbeda dengan kelompok Painting tools, Drawing and type tool berisi tool-tool untuk membuat obyek-obyek gambar yang tidak bisa dibuat dengan painting tools serta untuk membuat dan mengedit teks atau tulisan.
· Annotation, measuring and navigation tools
	Terdiri dari tool-tool yang membantu Anda membuat catatan, pengukuran panjang obyek dan navigasi saat bekerja di Photoshop.

Options Bar
	Options bar adalah fasilitas yang memberikan pilihan tambahan untuk setiap tool (alat) yang dipilih. Pilihan tambahan ini memungkinkan User mengontrol penggunaan tool bersangkutan sehingga pekerjaan lebih efektif. Untuk setiap tool temukan Options bar memunculkan pilihan tambahan yang berbeda. Contoh bawah ini adalah tampilan Options bar untuk Rectangular Marquee tool.

[image: ptions bar untuk Rectangular Marquee tool]
Gambar 3.7. Options bar untuk Rectangular Marquee tool

Document Window
	Document window adalah bagian paling penting dari pekerjaandi Photoshop. Ini adalah dokumen kerja, dimana gambar (image) akan dibuat, edit dan desain. User bisa membuat dokumen baru, atau membuka file gambar (image) yang sudah ada sebelumnya.


Panels
	Panel adalah fasilitas yang memungkinkan User memaksimalkan penggunaan tool, teknik dan efek yang dihasilkan di Photoshop. Terdapat beragam panel dengan berbagai kegunaan dan fungsinya masing-masing. Panel-panel utama yang sebaiknya diperhatikan adalah: Layers, Channels, History, Character dan Color.
	Guna menampilkan dan atau mengakses panel yang Anda inginkan bisa melalui menu Window > [Panel], atau dengan mengklik jendela panel di sebelah kanan area kerja.

[image: neka Panel di Photoshop ]
Gambar 3.8. Aneka Panel di Photoshop

Docks of Panels
	Docks of Panels adalah sekumpulan Panel yang dikecilkan dan disusun berurutan di sebelah kanan area kerja untuk memudahkan User dalam mengaksesnya. Ditampilkan sebagai ikon di mana saat User klik akan menampilkan box panel bersangkutan.
	[image: Fasilitas Docks of Panels]
Gambar 3.9. Fasilitas Docks of Panels

	Fasilitas-fasilitas di atas adalah bagian utama yang sebaiknya dikuasai. Masih banyak fasilitas dan fitur tambahan lainnya untuk dieksplorasi sejalan dengan seringnya menggunakan Photoshop. 

3.3 Membuat objek sederhana pada program Adobe Photoshop
Membuat objek sederhana dengan menggunakan Adobe Photoshop adalah merupakan standar bagi para Desainer, objek yang rumit selalu dapat disederhanakan menjadi objek geometris sederhana, untuk itu latihan modul pada bab ini adalah membuat objek sederhana dengan bentuk ilustrasi kartun, model objeknya adalah kartun wajah beruang. 

[image: :::::Downloads:29.jpg]
Gambar 3.10. Hasil akhir gambar kartun

	Langkah pertama siapkan dokumen baru pada Adobe Photoshop, kemudian atur settingan seperti pada gambar.
[image: ::::Screen shot 2016-11-23 at 2.42.21 AM.png]
Gambar 3.11. Kotak box new document

	Buat sebuah lingkaran menggunakan Lingkaran dengan menggunakan pen Tool , kemudian buat lagi lingkaran kecil untuk telinga beruang seperti step 2, lihat gambar. Buat lagi lingkaran kecil didalam lingkaran kecil tadi, di sini fill diisi warna hitam dan stroke di hilangkan.
[image: http://1.bp.blogspot.com/-9pITHypJrMk/UWZuZ4NafoI/AAAAAAAAM1U/IEzlqEtLvLI/s1600/04.jpg]
Gambar 3.12. Lingkaran dasar dan bagian telinga dengan menggunakan stroke

	Seleksi semua lingkaran, setelah itu klik object > Expand, untuk mengubah stroke menjadi fill. Hapus bagian yang tidak perlu, perhatikan path yang tak ada fill danstroke hapus path tersebut. Satukan semua path dengan group pada panel.
[image: http://1.bp.blogspot.com/-uiN7u22vtek/UWY__z2p0UI/AAAAAAAAM0s/B6jagiiFPyI/s1600/7.jpg]
Gambar 3.13. Detil bagian telinga
	Kemudian buat path kotak dengan Rectangel Tool (M). Tempatkan di sebelah kepala beruang , pilih kedua path (kepala beruang tanpa path kecil yang terpisah dan path kotak) lalu hapus bagian yang tidak diinginkan
[image: http://1.bp.blogspot.com/-bsKHleUBRxU/UWY_2cWvELI/AAAAAAAAMx0/RjGSZ2Sym-Y/s1600/10.jpg]
Gambar 3.14. Objek dasar bagian beruang 

	Setelah itu dengan menggunakan pen tool (P), buat bagian mata beruang, lihat gambar. Buat bagian putih didalamnya dengan menggunakan pen tool juga. Potong seperti pada langkah sebelumnya, menggunakan minus front  untuk menghilangkan bagian putih. Tambahkan path pada bagian mata warna hitam dengan menggunakan pen tool seperti tadi lalu gabungkan objek kembali.

[image: http://3.bp.blogspot.com/-7r57lKzDIGg/UWY_3vyI3tI/AAAAAAAAMyM/r2PqQ5clBdg/s1600/13.jpg]
Gambar 3.15. Pembuatan mata objek

	Buat segitiga kecil berwarna hitam menggunakan pen tool untuk membentuk hidung dan mulut.
[image: http://2.bp.blogspot.com/-goQOMjD4o3w/UWY_5Ru6ONI/AAAAAAAAMys/glFotKfVkS8/s1600/17.jpg]
Gambar 3.16. Detil mata, hidung dan mulut objek

	Copy dan Paste seluruh objek kemudian lakukan transform mirorring secara horizontal, Geser dan posisikan dengan benar  seperti pada gambar dibawah. Satukan dengan penggabungan kedua layer pada panel. Tahap berikutnya adalah pewarnaan logo, buat kotak bewarna coklat dengan rectangle tool (M). Tempatkan kotak tersebut dibelakang layer kepala beruang 
[image: http://3.bp.blogspot.com/-Ob54QDbWZl0/UWY_7gLV2CI/AAAAAAAAMzU/fSCmvu4FBSM/s1600/21.jpg]
Gambar 3.17. Hasil setelah di-copy, flip dan pemberian warna


	Ubah warna Kepala beruang menjadi coklat tua. Pilih kotak dan kepala beruang lalu pilih select kemudian hapus warna diluar outline beruang,  Kemudian hapus warna yang terdapat dibagian dalam mata dengan menggunakan tools select dan eraser, sehingga hasilnya akan terlihat seperti dibawah ini.

[image: http://3.bp.blogspot.com/-mJU9a4ZlGgA/UWY_9QK5jYI/AAAAAAAAMz4/u9jRiXKvDNY/s1600/27.jpg]
Gambar 3.18. Pemberian warna gelap dan menghapus setengah bagian warna

	Ubah warna  menjadi coklat yang lebih tua dengan menggunakan palet warna, kemudian buat kembali kotak yang besar sehingga memotong setengah bagian objek. Setelah membuat kotak tersebut, kotak dan bagian warna kepala beruang bagian atas dipotong dengan memilih  bagian diluar outline kemudian menghapus bagian tersebut. Sehingga sebagian objek gambar akan terlihat lebih gelap agar menimbulkan kesan estetis.
[image: :::::Downloads:29.jpg]
Gambar 3.19. Hasil akhirilustrasi kartun setelah memberikan warna cerah pada setengah bagian objek beruang

3.4 Mengetahui dan memahami cara render objek realistis dengan teknik digital painting
	Membuat objek dengan render realistis menggunakan Adobe Photoshop adalah merupakan standar bagi para Desainer, objek yang rumit selalu dapat disederhanakan menjadi pewarnaan sederhana, untuk itu latihan modul pada bab ini adalah membuat objek sederhana dengan bentuk ilustrasi realis, model objeknya adalah batu mulia sesuai dengan konsentrasi Desain perhiasan. Siapkan dokumen baru pada Adobe Photoshop, kemudian atur settingan seperti pada gambar.
	Langkah pertama siapkan dokumen baru pada Adobe Photoshop, kemudian atur settingan seperti pada gambar.
[image: ::::Screen shot 2016-11-23 at 2.42.21 AM.png]
Gambar 3.20. Pembuatan New Document

	Setelah bidang kerja sudah disiapkan, buatlah bidang background gambar dengan warna abu-abu, hal ini dimaksudkan agar dalam proses menggambar bisa lebih fokus, spektrum warna abu-abu membuat tampilan objek akan terlihat lebih kontras.
[image: ::::Screen shot 2016-11-23 at 2.32.40 AM.png]
Gambar 3.21. Area bidang kerja untuk Painting 
	Kemudian buatlah sebuah sketsa objek faceted stone dengan bentuk emerald dengan menambahkan garis facet.  Setelah garis facet dibuat, selanjutnya dapat dibuat garis facet tambahan. Garis Facet untuk gambar dengan template bentuk dapat dibuat dengan menghubungkan ujung-ujung sudut bentuk emerald luar dan dalam.  Dengan ada bantuan sketsa dan garis facet maka proses dalam digital painting akan lebih mudah.
	Garis facet tambahan dibuat untuk menentukan sudut cutting setiap batu, karena dalam proses painting setiap tepi dan sisi harus mempunyai karakter render yang benar. Arah pencahayaan dan karakteristik setiap batu memiliki kekhasan masing-masing. Sehingga untuk hasil optimal maka diperlukan pembuatan sketsa dan garis facet yang benar.

[image: ::::Screen shot 2016-11-23 at 2.23.27 AM.png]
Gambar 3.22. Gambar batu facet emerald
 
	Setelah proses pembuatan sketsa maka langkah selanjutnya adalah  pemberian warna, palet warna pada Photoshop banyak memberikan variasi, munculkan palet dilayer kerja untuk memudahkan pencarian turunan warna dalam merender. Blok warna batu emerald dengan warna hijau tua sebagai warna dasar (base colour), warna dasar akan menentukan kontras objek yang dirender.
[image: ::::Screen shot 2016-11-23 at 2.23.57 AM.png]
Gambar 3.22. Gambar batu facet emerald setelah diberi warna dasar

	Langkah berikutnya adalah pemberian warna turunan dan warna aksen untuk batu emerald, Lakukan dengan pertimbangan arah cahaya, dalam hal ini cahaya datang dari sudut atas kiri. Setiap tepian batu emerald setidaknya diberi warna turunan yang berbeda dengan warna dasar. Berikan warna dengan palet warna lebih dari 3 warna turunan, lihat contoh dibawah ini.

[image: ::::Screen shot 2016-11-23 at 2.24.30 AM.png]
Gambar 3.23. Pemberian warna blocking turunan 
	Kemudian langkah berikutnya adalah proses painting dengan menggunakan tool brush dan smudge. Pencampuran warna dengan menggunakan brush dilakukan dengan perlahan agar warna pada batu tetap terlihat kontras dan realistis. Pemberian warna yang lebih gelap dilakukan pada tepi yang terkena cahaya secara langsung, begitu pula pemberian warna cerah hanya dilakukan pada tepian batu yang terkena cahaya secara langsung. Batu Facetted Stone memiliki karakter membiaskan cahaya, sehingga pewarnaan setiap tepi batu memiliki unsur kompleksitas yang cukup rumit. Lakukan dengan perlahan agar gradasi warna tidak terlihat kontras, lihat contoh dibawah. 

[image: ::::Screen shot 2016-11-23 at 2.25.33 AM.png]
Gambar 3.24. Gambar batu facet emerald setelah di-painting dasar
	
	Selanjutnya adalah proses blending warna dengan menggunakan smudge tool. Smudge tool ada di tool box menu sebelah kanan dengan ikon berupa jari. Fungsinya adalah mencampur warna dengan halus. 

[image: ::::Screen shot 2016-11-23 at 3.12.30 AM.png]
Gambar 3.25. Icon Smudge Tool
	Lakukan smudging secara perlahan pada setiap tepian batu dengan brush opacity sebesar  20%. Selalu simpan (save) file secara berkala, menggunakan Smudge tool akan memproses perubahan citra dan komponen warna secara kompleks dan menyeluruh secara drastis dalam program Photoshop, hal ini mengakibatkan prosessor komputer akan bekerja dua kali lebih berat dibanding biasa. Oleh karena itu untuk menghindari Close Program atau program tertutup secara tiba-tiba maka menyimpan file secara berkala adalah sebuah keharusan.

[image: ::::Screen shot 2016-11-23 at 2.26.18 AM.png]
Gambar 3.26. Gambar batu facet emerald setelah di-smudge dengan perlahan

	Setelah proses smudging telah dilakukan maka proses berikutnya adalah pemberian aksen highlight (cahaya) dan shadow (bayangan). Buat layer baru agar tidak mengganggu layer base colour dan layer render dasar, layer baru ini digunakan untuk menggambar cahaya dan bayangan lebih komprehensif dengan menggunakan brush yang memiliki karakter tekstur keras (hard brush), lakukan dilayer dengan karakteristik overlay agar kontras cahaya dapat melebur dengan satu turunan warna.
[image: ::::Screen shot 2016-11-23 at 2.27.36 AM.png]
Gambar 3.27. Berbagai macam tipe Hard Brush dan Texture Brush

	Lakukan pewarnaan dengan perlahan agar tekstur pada batu lebih terlihat, pertimbangkan aspek keseimbangan dan kesatuan estetis agar render pada batu tidak terlihat terlalu berlebihan.
[image: ::::Screen shot 2016-11-23 at 2.27.49 AM.png]
Gambar 3.28. Gambar batu setelah dirender dengan hard dan texture brush


	Langkah terakhir adalah memberikan efek kontras dilayer baru. Efek ini dapat dibuat pada layer baru kemudian memberikan efek garis berwarna putih disetiap tepian atau sudut batu yang terkena cahaya langsung.

[image: ::::Screen shot 2016-11-23 at 2.28.06 AM.png]
Gambar 3.29. Gambar batu facet emerald setelah diberi efek highlight

	Setelah proses render terakhir sudah dilakukan, pewarnaan batu emerald juga bisa langsung dilakukan dengan otomatis apabila tahap render kontras highlight sudah selesai, Hal ini bida dilakukan dengan cara mengatur box saturation/hue. Caranya adalah menggeser tombol saturation maka warna setiap batu akan berubah dengan sendirinya sesuai dengan palet warna.

[image: ::::Screen shot 2016-11-23 at 2.31.52 AM.png]
Gambar 3.30. Hue dan Saturation untuk mengubah warna secara otomatis
	Batu emerald akan terlihat seperti dibawah ini, simpan setiap perubahan warna batu sebagai asset visual, sehingga dapat digunakan untuk proses gambar dikemudian hari. Dengan menyimpan file asset maka proses kerja akan lebih singkat dan efisien.

[image: ::::Screen shot 2016-11-23 at 2.31.29 AM.png]
Gambar 3.31. Warna batu yang sudah diedit dengan Box Saturation

	Lakukan eksperimen painting dengan batuan lainnya, pelajari setiap karakteristik bentuk batu, arah pencahayaan, logika rendering dan pewarnaan agar hasilnya lebih maksimal. Perlakuan painting setiap batu  selalu memiliki perbedaan, hal ini diakibatkan karena perbedaan pola cutting setiap batu.

[bookmark: _GoBack][image: ::::Screen shot 2016-11-23 at 2.41.15 AM.png]
Gambar 3.32. Proses render digital painting dengan karakter batu lainnya
3.5 Soal dan Jawab
	1. Apa fungsi Lasso tool dalam program Adobe Photoshop?
	Jawab : Sebagai alat bantu untuk menyeleksi gambar. Gambar yang diseleksi 	dengan Lasso tool akan berdiri sendiri sebagai gambar mandiri untuk diolah.

	2. Bagaimana membuat bayangan pada objek  Program Adobe Photoshop?
	Jawab : Menggunakan efek shadow pada Layer  objek yang akan dipilih.

	3. Apa fungsi transformasi dalam program Adobe Photoshop?
	Jawab : Fungsi transformasi adalah untuk memindah, mengubah, mengedit 	bentuk dasar objek bitmap.

3.6 Soal-soal
	1. Bagaimana proses dalam membuat ilustrasi di Photoshop ?
	2. Bagaiamana caranya memilih bagian tertentu dalam sebuah objek di 	program Photoshop? 
	3. Tools apa saa yang digunakan dalam membuat digital painting ?
	4. Apa fungsi tools brush?
	5. Apa fungsi tools smudge?

1 Lampiran : -

3. 7 Daftar Pustaka 
1.Pujiyanto.2005. Desain Grafis Komputer. Yogyakarta:Penerbit Andi.  
2.MADCOMS.2005. Seri Lengkap Adobe CS. Yogyakarta:Penerbit Andi
3.www.ilmugrafis.com
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